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XAUI Automated Testing—At A Glance
The Keysight N5431A/N5431B XAUI Electrical Validation Application helps you verify that your XAUI 
devices conform to specifications with the Keysight Infiniium digital storage oscilloscopes. The XAUI 
Electrical Validation Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

Specifications are described in sections 47 and 54 of the IEEE 802.3-2005 Standard. The N5413A 
also allows testing of common tests from the XAUI derived 10Gigabit Fibre Channel XAUI, CPRI, 
OBSAI, and Serial Rapid IO standards. For more information on XAUI, see the IEEE 802 Standards 
web site at www.ieee802.org. Also visit www.cpri.info, www.obsai.org and www.rapidio.org for more 
information on CPRI, OBSAI and Serial Rapid IO standards respectively.

NOTE
The tests performed by the XAUI Electrical Validation Application are intended to provide a quick check 
of the electrical health of the DUT. This testing is not a replacement for an exhaustive test validation 
plan.

http://www.ieee802.org
http://www.ieee802.org
http://www.cpri.info
http://www.obsai.org
http://www.rapidio.org
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In This Book
This manual describes the tests that are performed by the XAUI Electrical Validation Application in 
more detail; it contains information from (and refers to) the IEEE 802.3-2005 Standard, and it 
describes how the tests are performed.

• Chapter 2, “Installing the XAUI Electrical Validation Application shows how to install and license 
the automated test application software (if it was purchased separately).

• Chapter 3, “Preparing to Take Measurements shows how to start the XAUI Electrical Validation 
Application and gives a brief overview of how it is used.

• Chapter 4, “XAUI Tests contains more information on the XAUI tests.

• Chapter 5, “10GBASE-CX4 Tests contains more information on the 10GBASE-CX4 tests.

• Appendix 6, “Calibrating the Infiniium Oscilloscope and Probe describes how to calibrate the 
oscilloscope in preparation for running the XAUI automated tests.

• Appendix 7, “InfiniiMax Probing describes the InfiniiMax probe amplifiers and probe head 
recommendations for XAUI testing.

See Also

• The XAUI Electrical Validation Application’s online help, which describes:

• Creating or opening a test project.

• Setting up tests.

• Selecting tests.

• Configuring selected tests.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Viewing test results.

• Viewing/printing the HTML test report.

• Saving test projects.
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1 Overview

The N5431A/N5431B XAUI Electrical Validation Application performs the following tests as per the 
IEEE 802.3-2005 standards.

Table 1 XAUI Tests by Standard Reference

Standard Reference Description See

IEEE 802.3-2005, Section 47.3.3 Baud rate tolerance page 28

IEEE 802.3-2005, Section 47.3.3.2 Differential amplitude maximum page 29

IEEE 802.3-2005, Section 47.3.3.5 Driver template page 30

IEEE 802.3-2005, Section 47.3.3.5 Driver transmit jitter page 31

IEEE 802.3-2005, Section 47.3.3.3 Transition time page 33

Table 2 10GBASE-CX Tests by Standard Reference

Standard Reference Description See

IEEE 802.3-2005, Section 54.6.3.3 Baud rate tolerance page 40

IEEE 802.3-2005, Section 54.6.3.6 Differential output template page 41

IEEE 802.3-2005, Section 54.6.3.4 Data amplitude page 42

IEEE 802.3-2005, Section 54.6.3.7 Transition time page 44

IEEE 802.3-2005, Section 54.6.3.8 Driver transmit jitter page 45
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2 Installing the XAUI Electrical 
Validation Application

Installing the Software  /  12
Installing the License Key  /  13

If you purchased the N5431A/N5431B XAUI Electrical Validation Application separately, you need to 
install the software and license key.
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Installing the Software

1 Make sure you have version A.05.20 or higher of the Infiniium oscilloscope software by choosing 
Help>About Infiniium... from the main menu.

For oscilloscopes with operating software revisions A.03.xx, free upgrade software is available at 
http://www.keysight.com/find/infiniium_software.

2 To obtain the XAUI Electrical Validation Application, go to Keysight web site: 
http://www.keysight.com/find/scope-apps-sw

3 The link for XAUI Electrical Validation Application will appear. Double-click on it and follow the 
instructions to download and install the application software.

Be sure to accept the installation of the .NET Framework software; it is required in order to run 
the XAUI Electrical Validation Application.

http://www.keysight.com/find/infiniium_software
http://www.keysight.com/find/infiniium_software
http://www.keysight.com/find/scope-apps-sw
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Installing the License Key

1 Request a license code from Keysight by following the instructions on the Entitlement Certificate.

You will need the oscilloscope's “Option ID Number”, which you can find in the Help>About 
Infiniium... dialog.

2 After you receive your license code from Keysight, choose Util ities>Install Option License....

3 In the Install Option License dialog, enter your license code and click Install License.

4 Click OK in the dialog that tells you to restart the Infiniium oscilloscope application software to 
complete the license installation.

5 Click Close to close the Install Option License dialog.

6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application software to complete the license installation.
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3 Preparing to Take 
Measurements

Required and Recommended Equipment  /  16
Calibrating the Oscilloscope  /  18
Starting the XAUI Electrical Validation Application  /  19

Before running the XAUI automated tests, you need to acquire the appropriate test fixtures, and you 
should calibrate the oscilloscope. After the oscilloscope has been calibrated, you are ready to start 
the XAUI Electrical Validation Application and perform measurements.
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Required and Recommended Equipment

Oscilloscope Compatibility and Recommended Probe Amplifiers

Number of Probes or SMA Cables Required

Table 3 Recommended Oscilloscopes and Recommended Probe Amplifiers

Standard Data Rate Recommended 
Oscilloscope

Oscilloscope 
Band wid th

Recommended 
Probe

Probe 
Band wid th

XAUI 10 Gigabyte Ethernet 
(4x3.125 GBaud)

Infiniium ≥ 4 GHz 1134A series ≥ 4 GHz

Table 4 Number of Probes or SMA Cables Required

Probes and BNC Cables XAUI Measurements

InfiniiMax active differential probe 1

SMA cables 2
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Preparing to Take Measurements 3

Recommended Accessories

Recommended Infiniium Oscilloscope

• For jitter test the 80000 Series oscilloscopes with option 001 are recommended for best 
performance.

Required Software

• Version A.05.10 or higher of the Infiniium oscilloscope software.

Table 5 Recommended Test Accessories

Keysight Part Number Description

8120-1839 BNC cable (61 cm, 2 ft.)

08760-82382 SMA cable (31 cm, 1 ft.)

08760-82386 SMA cable (62 cm, 2 ft.)
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Calibrating the Oscilloscope

If you haven’t already calibrated the oscilloscope, see Appendix 6, “Calibrating the Infiniium 
Oscilloscope and Probe.

NOTE
If the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, 
internal calibration should be performed again. The delta between the calibration temperature and 
the present operating temperature is shown in the Utilities>Calibration menu.

NOTE
If you switch cables or probes between channels or other oscilloscopes, it is necessary to perform 
cable and probe calibration again. Keysight recommends that, once calibration is performed, you 
label the cables with the channel for which they were calibrated.
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Starting the XAUI Electrical Validation Application

1 From the Infiniium oscilloscope’s main menu, choose Analyze>Automated Test Apps>XAUI Test.

Figure 1 Accessing the XAUI Electrical Validation Application

Figure 2 The XAUI Electrical Validation Application

NOTE
If XAUI does not appear in the Automated Test Apps menu, the XAUI Electrical Validation 
Application has not been installed (see Chapter 2, “Installing the XAUI Electrical Validation 
Application).
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Figure 2 shows the XAUI Electrical Validation Application main window. The task flow pane, and 
the tabs in the main pane, show the steps you take in running the automated tests:

Tab Description

Set Up Lets you select the XAUI device test point being tested. Lets you select the connection type: Differential or 
Single-ended. If Differential is selected, lets you choose which Lane is being tested.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select all tests in a 
group. After tests are run, status indicators show which tests have passed, failed, or not been run, and there are 
indicators for the test groups.

Configure Lets you enter information about the device being tested and configure test parameters (like memory depth). 
This information appears in the HTML report.

Connect Shows you how to connect the oscilloscope to the device under test for the tests to be run.

Run Tests Starts the automated tests. If the connections to the device under test need to be changed while multiple tests 
are running, the tests pause, show you how to change the connection, and wait for you to confirm that the 
connections have been changed before continuing.

Results Contains more detailed information about the tests that have been run. You can change the thresholds at which 
marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed. You can choose between a verbose and compact report.
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Preparing to Take Measurements 3

Online Help Topics

For information on using the XAUI Electrical Validation Application, see its online help (which you can 
access by choosing Help>Contents... from the application’s main menu).

The XAUI Electrical Validation Application’s online help describes:

• Creating or opening a test project.

• Setting up tests and equipment.

• Selecting tests.

• Configuring selected tests.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Viewing test results.

• To show reference images and flash mask hits.

• To change margin thresholds.

• Viewing/printing the HTML test report.

• Saving test projects.
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4 XAUI Tests

Probing for XAUI Tests  /  24
Baud Rate Test  /  28
Driver Output Amplitude Test  /  29
Driver Eye Template Test  /  30
Driver Transmit Jitter Tests  /  31
Transition Time Tests  /  33

This section provides the Methods of Implementation (MOIs) for the XAUI 10 GBd tests using a 
Keysight Infiniium oscilloscope, probes, and the XAUI Electrical Validation Application.
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Probing for XAUI Tests

Connectivity for XAUI tests depends on the type of connection on the board you are testing. If you 
are soldering to the DUT you can use the E2677A solder-in probe head or the N5425A ZIF probe 
head available for the 1134A InfiniiMax probe. If you are connecting to SMA connectors you can use 
the SMA probe head available for the 1134A InfiniiMax probe or you can use two SMA cables. The 
following figures show the different connection configurations.

Using the E2677A Solder-in Probe Head and the 1134A InfiniiMax Probe

1 Connect the InfiniiMax probe with solder-in probe head to the XAUI test points and to the 
oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the XAUI Automated Test Application’s Setup tab, select Differential for the connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in Figure 5 
is just for example.)

Figure 3 Probing using the solder-in probe head and the 1134A probe.

1134A InfiniiMax probe and E2677A solder-in 
probe head
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Using the N5431A/N5431B ZIF Probe Head and the 1134A InfiniiMax Probe

1 Connect an InfiniiMax probe with ZIF probe head to the XAUI test points and to the oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the XAUI Automated Test Application’s Setup tab, select Differential for the connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in Figure 5 
is just for example.)

Figure 4 Probing using the ZIF probe head and the 1134A probe.

1134A InfiniiMax probe and N5425A ZIF probe 
head
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Using the SMA Probe Head and the 1134A InfiniiMax Probe

1 Connect an InfiniiMax probe with SMA probe head to the XAUI test points and to the 
oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the XAUI Automated Test Application’s Setup tab, select Differential for the connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in Figure 5 
is just for example.)

 

InfiniiMax probe and N5380A SMA 
probe head

Figure 5 Probing using the SMA probe head and the 1134A probe.
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Using Two SMA Cables

When you are testing a XAUI waveform that has a dc offset voltage you will need to use two blocking 
capacitors such as the Keysight 11742A.

1 Connect the two SMA cables to the XAUI test points.

2 Connect the two SMA cables to the oscilloscope.

3 In the XAUI Automated Test Application’s Setup tab, select Single-ended for the connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in Figure 6 
is just for example.)

Figure 6 Probing using two SMA cables.

SMA cables

blocking capacitors if 
required
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Baud Rate Test

Baud Rate Test

The Baud Rate tests is to verify that the differential output baud rate of the device under test (DUT) is 
within the conformance limits.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.3.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the “Select Tests” tab.

2 Press the “Run Tests” button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to “I have completed these instructions” near the bottom of this dialog. Then, press the 
“Next” button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

3.125 GBd ±100 ppm
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Driver Output Amplitude Test

Driver Output Amplitude Test

The Driver Output Amplitude test is to verify that the differential output voltage of the device under 
test (DUT) is within the conformance limits.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.2.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the “Select Tests” tab.

2 Press the “Run Tests” button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to “I have completed these instructions” near the bottom of this dialog. Then, press the 
“Next” button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

1600 mVp-p
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Driver Eye Template Test

Driver Eye Template Test

The Driver Eye Template test is provided for informative purposes. The specification does not require 
that this test be run, but it may be useful in providing insight of potential signal quality issues.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.5.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Select the “Data Eye Test Mask” to use in the “Configure” tab.

3 Press the "Run Tests" button in the task flow to start testing.

4 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

5 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

No mask failures.
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Driver Transmit Jitter Tests

Total Jitter Test

The Total Jitter test ensures that the total transmit jitter of the signal is within conformance limits.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.5.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Select the “Data Eye Test Mask” to use in the “Configure” tab.

3 Press the "Run Tests" button in the task flow to start testing.

4 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

5 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

±0.175 peak from the mean (near-end maximums) UI

±0.275 peak from the mean (far-end maximums) UI

Deterministic Jitter Test

The Deterministic Jitter test ensures that the deterministic jitter of the signal is within conformance 
limits.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.5.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.
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Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Select the “Data Eye Test Mask” to use in the “Configure” tab.

3 Press the "Run Tests" button in the task flow to start testing.

4 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

5 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

±0.085 peak from the mean (near-end maximums) UI

±0.185 peak from the mean (far-end maximums) UI
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Transition Time Tests

Rise and Fall Time Tests

The Transition Time tests ensure that the rise time and fall time of the signal are within the 
conformance requirements.

References

[1] IEEE 802.3ae-2002, subclause 47.3.3.3.

Probing Setup

Refer to “Probing for XAUI Tests" on page 24. This probing configuration is used for all XAUI tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

30 ps < Trise < 130 ps

30 ps < Tfall < 130 ps
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This section provides the Methods of Implementation (MOIs) for the 10GBASE-CX4 tests using a 
Keysight Infiniium oscilloscope, probes, and the XAUI Electrical Validation Application.
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Probing for 10GBASE-CX4 Tests

Connectivity for 10GBASE-CX4 tests depends on the type of connection on the board you are 
testing. If you are soldering to the DUT you can use the E2677A solder-in probe head or the N5425A 
ZIF probe head available for the 1134A InfiniiMax probe. If you are connecting to SMA connectors 
you can use the SMA probe head available for the 1134A InfiniiMax probe or you can use two SMA 
cables. The following figures show the different connection configurations.

Using the E2677A Solder-in Probe Head and the 1134A InfiniiMax Probe

1 Connect the InfiniiMax probe with solder-in probe head to the 10GBASE-CX4 test points and to 
the oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the 10GBASE-CX4 Automated Test Application’s Setup tab, select Differential for the 
connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in 
Figure  9 is just for example.)

Figure 7 Probing using the solder-in probe head and the 1134A probe.

1134A InfiniiMax probe and E2677A solder-in 
probe head
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Using the N5431A/N5431B ZIF Probe Head and the 1134A InfiniiMax Probe

1 Connect an InfiniiMax probe with ZIF probe head to the 10GBASE-CX4 test points and to the 
oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the 10GBASE-CX4 Automated Test Application’s Setup tab, select Differential for the 
connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in 
Figure  9 is just for example.)

Figure 8 Probing using the ZIF probe head and the 1134A probe.

1134A InfiniiMax probe and N5425A ZIF probe 
head
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Using the SMA Probe Head and the 1134A InfiniiMax Probe

1 Connect an InfiniiMax probe with SMA probe head to the 10GBASE-CX4 test points and to the 
oscilloscope.

2 Ensure the correct polarity of the probe head.

3 In the 10GBASE-CX4 Automated Test Application’s Setup tab, select Differential for the 
connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in 
Figure  9 is just for example.)

Figure 9 Probing using the SMA probe head and the 1134A probe.

InfiniiMax probe and N5380A SMA 
probe head
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Using Two SMA Cables

When you are testing a 10GBASE-CX4 waveform that has a dc offset voltage you will need to use 
two blocking capacitors such as the Keysight 11742A.

1 Connect the two SMA cables to the 10GBASE-CX4 test points.

2 Connect the two SMA cables to the oscilloscope.

3 In the 10GBASE-CX4 Automated Test Application’s Setup tab, select Single-ended for the 
connection type.

You can use any of the oscilloscope channels for probing the test point. You can identify the channel 
used in the Configure tab of the XAUI Electrical Validation Application. (The channel shown in 
Figure  10 is just for example.)

Figure 10 Probing using two SMA cables.

SMA cables

blocking capacitors if 
required
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Baud Rate Test

Baud Rate Test

The Baud Rate tests is to verify that the differential output baud rate of the device under test (DUT) is 
within the conformance limits.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.3.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the “Select Tests” tab.

2 Press the “Run Tests” button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to “I have completed these instructions” near the bottom of this dialog. Then, press the 
“Next” button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

3.125 GBd ±100 ppm
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Differential Output Template Test

Differential Output Template Test

The Differential Output Template test is provided for informative purposes. The specification does not 
require that this test be run, but it may be useful in providing insight of potential signal quality issues.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.6.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the low-frequency test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd low-frequency signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

No mask failures.
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Data Amplitude Tests

The Data Amplitude tests are to verify that the differential output voltage of the device under test 
(DUT) is within the conformance limits.

Differential Output Amplitude Test

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.4.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the low-frequency test pattern.

Performing the Test

1 Ensure this test is checked to run in the “Select Tests” tab.

2 Press the “Run Tests” button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to “I have completed these instructions” near the bottom of this dialog. Then, press the 
“Next” button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd low-frequency test signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

Minimum = 800 mVp-p

Maximum = 1200 mVp-p

Lane-to-Lane Amplitude Difference Test

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.4.

Probing Setup

For this test, only the differential probing configurations can be used and not the single-ended 
probing configuration. Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration 
is used for all 10GBASE-CX4 tests.
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Device Configuration

1 Configure the DUT for 10 GBd operation using the low-frequency test pattern.

Performing the Test

1 Ensure this test is checked to run in the “Select Tests” tab.

2 Press the “Run Tests” button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to “I have completed these instructions” near the bottom of this dialog. Then, press the 
“Next” button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd low-frequency test signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

150 mVp-p
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Transition Time Tests

Rise and Fall Time Tests

The Transition Time tests ensure that the rise time and fall time of the signal are within the 
conformance requirements.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.7.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the high-frequency test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd high-frequency test signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

60 ps < Trise < 130 ps

60 ps < Tfall < 130 ps
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Driver Transmit Jitter Tests

Random Jitter Test

The Random Jitter test ensures that the random transmit jitter of the signal is within conformance 
limits.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.8.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

0.27 UI

Deterministic Jitter Test

The Deterministic Jitter test ensures that the deterministic jitter of the signal is within conformance 
limits.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.8.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.
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Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

0.17 UI

Total Jitter Test

The Total Jitter test ensures that the total transmit jitter of the signal is within conformance limits.

References

[1] IEEE 802.3ak-2004, subclause 54.6.3.8.

Probing Setup

Refer to “Probing for 10GBASE-CX4 Tests" on page 36. This probing configuration is used for all 
10GBASE-CX4 tests.

Device Configuration

1 Configure the DUT for 10 GBd operation using the CJPAT test pattern.

Performing the Test

1 Ensure this test is checked to run in the "Select Tests" tab.

2 Press the "Run Tests" button in the task flow to start testing.

3 If the system is not physically configured to perform this test, the application will prompt you to 
change the physical configuration. When you have completed these instructions, check the box 
next to "I have completed these instructions" near the bottom of this dialog. Then, press the 
"Next" button to continue testing.

4 The test will:

• Verify that the correct test signal is present on the configured Data channel.

• Configure the oscilloscope to capture a 3.125 GBd CJPAT signal.

• Test the signal against conformance parameters, recording the result.

Test Limits

0.35 UI
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This appendix describes the Keysight Infiniium digital storage oscilloscope calibration procedures.
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Required Equipment for Calibration

To calibrate the Infiniium oscilloscope in preparation for running the XAUI automated tests, you need 
the following equipment:

All Infiniium Oscilloscopes

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

80000 Series Infiniiums

• Calibration cable.

• Use a good quality 50 Ω BNC cable, that you provide.

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, qty = 2.

 Figure 11 below shows a drawing of the above connector items.

5485xA Series Infiniiums

• BNC shorting cap.

• Calibration cable (54855A only).

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, qty = 2 (54855A only).

• Use a good quality 50 Ω BNC cable, that you provide.

Figure 11 Accessories Provided with the Keysight Infiniium Oscilloscope

Precision 3.5 mm Adaptors (2)
BNC Shorting Cap
(Used to calibrate 5485xA 
series oscilloscopes)

Calibration Cable
(Used to calibrate 54855A 
and 80000 Series 
oscilloscopes)
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Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. For the Keysight 
oscilloscope, this is referred to as Calibration. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the oscilloscope.

b Plug in the power cord.

c Turn on the oscilloscope by pressing the power button located on the lower left of the front 
panel.

d Allow the oscilloscope to warm up at least 30 minutes prior to starting the calibration 
procedure in step 2 below.

2 Referring to  Figure 12 below, perform the following steps:

a Click on the Utilities>Calibration menu to open the Calibration dialog box.

b Uncheck the Cal Memory Protect checkbox.

c Click the Start button to begin the calibration.

d Follow the on-screen instructions.

Figure 12 Accessing the Calibration Menu.



6 Calibrating the Infiniium Oscilloscope and Probe

50 XAUI Electrical Validation Application Methods of Implementation

e Early during the calibration of channel 1, if you are prompted to perform a Time Scale 
Calibration, as shown in  Figure 13 below.

Figure 13 Time Scale Calibration Dialog box

f Click on the Default button to continue the calibration, using the Factory default calibration 
factors.

g When the calibration procedure is complete, you will be prompted with a Calibration Complete 
message window. Click the OK button to close this window.

h Confirm that the Vertical and Trigger Calibration Status for all Channels passed.

i Click the Close button to close the calibration window.

j The internal calibration is completed.

k Read NOTE below.

NOTE
These steps do not need to be performed every time a test is run. However, if the ambient 
temperature changes more than 5 degrees Celsius from the calibration temperature, this 
calibration should be performed again. The delta between the calibration temperature and the 
present operating temperature is shown in the Utilities>Calibration menu.
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Required Equipment for Probe Calibration 

Before performing XAUI tests you should calibrate the probes. Calibration of the solder-in probe 
heads consist of a vertical calibration and a skew calibration. The vertical calibration should be 
performed before the skew calibration. Both calibrations should be performed for best probe 
measurement performance.

The calibration procedure requires the following parts.

• BNC (male) to SMA (male) adaptor

• Deskew fixture

• 50 Ω SMA terminator
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Probe Calibration

Connecting the Probe for Calibration

For the following procedure, refer to  Figure 14 below.

1 Connect BNC (male) to SMA (male) adaptor to the deskew fixture on the connector closest to the 
yellow pincher.

2 Connect the 50 Ω SMA terminator to the connector farthest from yellow pincher.

3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium oscilloscope.

4 Connect the probe to an oscilloscope channel.

5 To minimize the wear and tear on the probe head, it should be placed on a support to relieve the 
strain on the probe head cables.

6 Push down on the back side of the yellow pincher. Insert the probe head resistor lead underneath 
the center of the yellow pincher and over the center conductor of the deskew fixture. The 
negative probe head resistor lead or ground lead must be underneath the yellow pincher and 
over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the 
probe head is approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.
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Figure 14 Solder-in Probe Head Calibration Connection Example

BNC

BNC to SMA

Connector

Pincher

50Ω SMA 
Terminator

Deskew 
Fixture
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Verifying the Connection

1 On the Infiniium oscilloscope, press the autoscale button on the front panel.

2 Set the volts per division to 100 mV/div.

3 Set the horizontal scale to 1.00 ns/div.

4 Set the horizontal position to approximately 3 ns. You should see a waveform similar to that in  
Figure 15 below.

If you see a waveform similar to that of  Figure 16 below, then you have a bad connection and 
should check all of your probe connections.

Figure 15 Good Connection Waveform Example
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Figure 16 Bad Connection Waveform Example
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Running the Probe Calibration and Deskew

1 On the Infiniium oscilloscope in the Setup menu, select the channel connected to the probe, as 
shown in  Figure 17.

Figure 17 Channel Setup Window.
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2 In the Channel Setup dialog box, select the Probes... button, as shown in  Figure 18.

Figure 18 Channel Dialog Box

3 In the Probe Setup dialog box, select the Calibrate Probe... button.

4 In the Probe Calibration dialog box, select the Calibrated Atten/Offset radio button.

Figure 19 Probe Setup Window.
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5 Select the Start Atten/Offset Calibration... button and follow the on-screen instructions for the 
vertical calibration procedure. 

6 Once the vertical calibration has successfully completed, select the Calibrated Skew... button.

7 Select the Start Skew Calibration... button and follow the on-screen instructions for the skew 
calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration was or was not 
successful.

Figure 20 Probe Calibration Window.
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Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this verification. However, 
if you want to verify that the probe was properly calibrated, the following procedure will help you 
verify the calibration.

The calibration procedure requires the following parts:

• BNC (male) to SMA (male) adaptor

• SMA (male) to BNC (female) adaptor

• BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838

• Keysight 54855-61620 calibration cable (Infiniium oscilloscopes with bandwidths of 6 GHz and 
greater only)

• Keysight 54855-67604 precision 3.5 mm adaptors (Infiniium oscilloscopes with bandwidths of 6 
GHz and greater only)

• Deskew fixture

For the following procedure, refer to  Figure 21.

1 Connect BNC (male) to SMA (male) adaptor to the deskew fixture on the connector closest to the 
yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the yellow pincher.

3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the deskew fixture to one 
of the unused oscilloscope channels. For infiniium oscilloscopes with bandwidths of 6 GHz and 
greater, use the 54855-61620 calibration cable and the two 54855-64604 precision 3.5 mm 
adaptors.

4 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium oscilloscope.

5 Connect the probe to an oscilloscope channel.

6 To minimize the wear and tear on the probe head, it should be placed on a support to relieve the 
strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head resistor lead underneath 
the center of the yellow pincher and over the center conductor of the deskew fixture. The 
negative probe head resistor lead or ground lead must be underneath the yellow pincher and 
over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the 
probe head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.

9 On the oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the channel connected to the BNC cable from the pull-down 
menu.

11 Select the Probes... button.

12 Select the Configure Probe System button.

13 Select User Defined Probe from the pull-down menu.

14 Select the Calibrate Probe... button.

15 Select the Calibrated Skew radio button.

16 Once the skew calibration is completed, close all dialog boxes.
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17 Select the Start Skew Calibration... button and follow the on-screen instructions.

Figure 21 Probe Calibration Verification Connection Example

BMC to SMA 
Connector

Pincher

Deskew 
Fixture

50Ω SMA 
Connector
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18 Set the vertical scale for the displayed channels to 100 mV/div.

19 Set the horizontal range to 1.00 ns/div.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the dialog box, you should 
see waveforms similar to that in  Figure 22.

Figure 22 Calibration Probe Waveform Example

NOTE
Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch 
probes between channels or other oscilloscopes, or it will be necessary to calibrate them again. It 
is recommended that the probes be labeled with the channel on which they were calibrated.
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7 InfiniiMax Probing

Keysight recommends the E2677A differential soldier-in probe head, the E2695A SMA probe head, 
or the N5425A ZIF probe head. Recommended probe heads include 1134A, 1168A and 1169A.

Figure 23 Example of InfiniiMax Probe Amplifier

Figure 24 Recommended E2677A Soldier-in Probe Head for XAUI Testing
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Figure 25 Example of SMA Probe Head for XAUI Testing

Figure 26 Recommended N5425A ZIF Probe Head for XAUI Testing

Table 6 Probe Head Characteristics (when used with DSO81304B and 1168A/69A probe amplifiers)

Probe Head Model 
Number

Differential Measurement
(BW, input C, input R)

Single-Ended Measurement
(BW, input C, input R)

Differential soldier-in E2677A 12 GHz, 0.27 pF, 50 kOhm 12 GHz, 0.44 pF, 25 kOhm

Differential soldier-in N5381A 12 GHz, 0.21 pF, 50 kOhm 12 GHz, 0.35 pF, 25 kOhm

SMA N5380A 12 GHz 12 GHz

SMA E2695A 8 GHz 8 GHz

ZIF N5425A 12 GHz, 0.33 pF, 50 kOhm 12 GHz, 0.53 pF, 25 kOhm
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